BAB 12

Modul : Grass

GRASS (Geographic Resources Analysis Support System) merupakan perangkat lunak SIG
open source yang memiliki banyak fungsi SIG dan sudah dikenal dengan baik. GRASS dirilis
pertama kali tahun 1984, dan sejak itu mengalami banyak perbaikan dan penambahan fungsi.
QGIS memungkinkan Anda untuk memantfaatkan tool-tool GRASS secara langsung.

12.1 Pelajaran :Pengaturan GRASS

Menggunakan GRASS di QGIS mengharuskan Anda untuk memikirkan antarmuka dengan
cara yang sedikit berbeda. Anda tidak bekerja di QGIS langsung, tetapi bekerja dalam GRASS
melalui QGIS.

Tujuan untuk pelajaran ini: untuk memulai sebuah proyek GRASS di QGIS.

£
12.1.1 9" Ikuti bersama: Mulai Proyek GRASS Baru

Untuk menjalankan GRASS dari dalam QGIS, Anda perlu mengaktifkannya seperti dengan
plugin yang lain.

* Dalam Plugin Manager, aktifkan GRASS yang ada dalam daftar:
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& QGIS Plugin Manager

Filker

To enable | disable a plugin, click its checkbox or description

Dxf2shp Converter

s Converts From dxf ko shp file Format
Installed in ¥ector menu;/toolbar

GPS Tools
P Tools For loading and importing GPS data

Installed in ¥ector menu;toolbar

GRASS

GRASS |aver

Installed in Plugins menu,/toolbar

GdalTools (Yersion 1.2.29)

x B Integrate gdal bools inko qgis
Installed’in Raster menu,/toolbar

Georeferencer GDAL

{.J_'i GenreFerencin& rasters using GOAL
Installed in Raster menu,/toolbar

Flugin Directory: C: fOSGeodn fapps/qois-dev)plugins

Select Al

Clear all Cancel

Toolbar GRASS akan muncul:

"TPELT TR I

Sebelum Anda dapat menggunakan GRASS, Anda perlu membuat sebuah mapset. GRASS
selalu bekerja dalam lingkungan basis data, yang berarti Anda perlu mengimpor semua data

yang ingin Anda gunakan ke dalam basis data GRASS.

* Untuk memulai, klik tombol New mapset:

R |

Anda akan melihat dialog seperti di bawah, yang menjelaskan struktur dari mapset

GRASS.

e Buat direktori baru bernama grass_ db di folder exercise_data.

* atur sebagai direktori yang akan digunakan oleh GRASS untuk membuat basis data:

298

Bab 12. Modul : Grass



Quantum GIS Training Manual, Rilis 1.0

& New Mapset

GRASS Database

Select existing direckory or create a new one:

Database: exercise_data/grass_db Browse, .
GRASS data are stored Example directory tree:
in tree directory Tree Comment
structure. ThE GRASS El- OurDakabase Database
database is the top-level Bl Mexica Location 1
directory in this tree { i PERMAMENT Syskem mapset
structure. i i Alejandra User's mapset
i e Juan User's mapset
[=F Mew Zealand Location 2
o PERMAMNEMT Svskem mapsek
o Zimrman User's mapset
< Barck ] [ Mextk = Zancel

GRASS perlu membuat “lokasi”, yang menggambarkan luasan maksimum daerah geografis

dimana Anda akan bekerja di dalamanya.

 Sebut lokasi baru tersebut sebagai South_Africa:

12.1. Pelajaran :Pengaturan GRASS
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& New Mapset

GRASS Location

Locakion

() Select location | = ]

® Create new location | SouthAfrica

The GRASS |location is a collection of maps for a paricular territary ar project.

* Kita akan bekerja dengan WGS 84, jadi cari dan pilih CRS ini:
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& New Mapset

Projection

Coordinate system
Mok defined

® Projection

Filter ' 4326

Recently used coordinate references systems

Conrdinate Reference Swakem

i W35 84

autharity 10D

EPSiE:4326

1 | (4]
Coordinate reference systems of the world Hide deprecated CR5s
|C|:n:ur|:|inate Feference System Autharity I0
=- '@' Gecgraphic Coordinate Systems
e WS B EPSiG:4 326

(<]

+proj=longlat +datum=W3584 +no_defs

% Back Cancel

 Sekarang pilih wilayah South Africa , yang sudah didefinisikan dalam GRASS:

12.1. Pelajaran :Pengaturan GRASS
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& New Mapset

Default GRASS Region

i -21.27
W 13.65 E 33.95
5 -35.9
Set current QEIS extent | South Africa B Set

The GRASS region defines aworkspace for raster modules. The default region is valid
for one location. tis possible to set a different region in each mapset. ltis possible to
change the default location regian later,

; < Back |! Mext = | | Cancel

* Buat mapset, yang merupakan file peta yang akan Anda kerjakan.
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& New Mapset

Mapset

Mew mapset: |grass_mapset|

The GRASS mapsetis a collection of maps used by one user Auser can read maps
from all mapsets in the location but he can open forwriting only his mapset (owned by
user.

< Back Zancel

Setelah Anda selesai, Anda akan melihat kotak dialog yang meminta Anda untuk mengkonfir-
masi bahwa pengaturan tampilan ini sudah benar.

e Klik Finish.

* kemudian klik OK pada dialog sukses.

12.1.2 & Ikuti bersama : Memuat Data Vektor ke dalam GRASS

Sekarang Anda akan memiliki peta kosong. Untuk memuat data ke dalam GRASS, Anda perlu
mengikuti proses dua langkah.

e Pertama, muat data ke QGIS seperti biasa.  Untuk saat ini gunakan dataset
streets.shp (temukan di dalam folder exercise_data/).

» Segera setelah data tersebut dimuat, klik tombol GRASS Tools:

¥

* Temukan fool untuk mengimpor vektor dengan memasukkan ... berikut:
v.in.ogr.qggis dalam pilihan Filter dari kotak dialog yang muncul.

v merupakan singkatan dari “vector”, in merupakan fungsi untuk mengimpor data ke dalam
basis data GRASS, ogr merupakan library perangkat lunak yang digunakan untuk membaca
data vektor, dan ggis merupakan ool untuk melihat data vektor diantara data vektor yang
telah disimpan dalam QGIS.

* Setelah menemukan tool ini, klik pada tool tersebut sehingga akan muncul:
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& GRASS Tools: South_Africa/grass_mapset

Modules Tree | Maodules Lisk | Browuser I S f l

Module: w.in.ogr.ggis

Options | Qutput | Manual |

~Loaded lawver

[Select a layer | ‘r]

Password

I I

~Mame For oukput weckar map

[ |

Run Wiew output

Close

* Atur layer yang dimuat ke dalam streets dan ubah nama file versi GRASS menjadi
:kbd:‘g_streets‘s untuk menghindari kebingungan.

304 Bab 12. Modul : Grass



Quantum GIS Training Manual, Rilis 1.0

& GRASS Tools: South_Africa/grass_mapset

Modules Tree | Modules List | Browser | 7 %

Module: +.in.ogr.gais

Options | OQubput | Manual |

Loaded layer

skresks -

Password

[ )

Mame for output veckar map —

I q_streets I

R Wiew outpuk Close

Close

Catatan: & Note the extra import options provided under Advanced Options. These inclu-
de the ability to add a WHERE clause for the SQL query used for importing the data.

Klik Run untuk memulai import.

Setelah selesai, klik tombol View output untuk melihat /ayer GRASS yang baru diimpor
ke dalam peta.

Tutup terlebih dahulu import fool tersebut (klik tombol Close di sebelah kanan View
output), kemudian tutup jendela GDAL Tools.

Hapus layer awal roads_33S.

Sekarang yang tersisa hanya layer GRASS yang telah diimpor seperti yang ditampilkan dalam
peta QGIS Anda.

12.1.
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3
12.1.3 ¥ Ikuti bersama: Memuat Data Raster ke dalam GRASS

DEM yang kita gunakan memiliki sistem proyeksi CRS UTM 33S / WGS 84, sedangkan
projek GRASS kita menggunakan sistem proyeksi Geographic CRS WGS 84. Jadi mari kita
lakukan proyeksi ulang DEM terlebih dahulu.

* Muat dataset srtm_41_19.tif (data disimpan dalam folder
exercise_data/raster/SRTM/) ke dalam peta QGIS seperti biasa, meng-
gunakan tool Add Raster Layer.

* Lakukan proyeksi ulang menggunakan tool GDAL Warp (Raster — Projections — Warp
(Reproject)). Cara pengaturannya ditunjukkan dalam kotak dialog berikut:
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& Warp (Reproject)

Bakch mode (For processing whole direckory)
Input File srbmn_41_19.kF | = Select, ..

Cutput File TIIDEM_SWiESE4 L Select. ..
X Source SRS EP3E:32733 Select. ..

X Target SRS EPSGi4326 Select...

®| Fesampling method Mear

Mo data walues [l:l ]

Mask laver [ "]| Select, .. |

Mernory used For caching [EDME

Resize

width | 3000 = Height | 3000

IUse multithreaded warping implementation

X Loadinto canvas when finished

* Simpan data raster di dalam folder yang sama seperti aslinya, tetapi dengan nama file
DEM_WGS84.tif. Setelah muncul di peta, hapus dataset srtm_41_19.tif dari
Layers list Anda.

Sekarang lakukan proyeksi ulang, anda dapat memuat ke dalam basis data GRASS Anda.
* Buka kotak dialog GRASS Tools lagi.
* Klik pada tab Modules List .
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e Carir.in.gdal.qggis:

k¢ GRASS Tools: South_Africalgrass_mapset

Modules Tree | Modules List | Browser |

Filter [r.in.gu:lal.qgis

L ':rl> Q r.in.gdal.qais. loc
iy Import loaded raster and create a fitked lacation

rin.gdal.ggis

Import lnaded rasker
N :|> r.in.gdal.qais
@ Impart lnaded raster

L ':b r.in.gdal.gais. loc
Impart lnaded raster and create a fitted lacation

Close

Yang memberi Anda tool ini:
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& GRASS Tools: South_Africa/grass_mapset

Modules Tree Modules Lisk Browser o

Module: rin.gdal. gois
Options Cubput: Manual |

Loaded layer

Select a laver -

Password

Mame for output raster map —

5

q_dem

R Wigw oukpuk Close

Close

Lakukan pengaturan seperti ditunjukkan (layer input DEM_WGS84, hasilnya g_dem).

Klik Run.

Ketika proses selesai, klik View output.

Selanjutnya Close tab saat ini dan Close kotak dialog keseluruhan .

Lawers @
- Li:“ g_streets

8t - ?g_dem

® Control rendering order
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* Sekarang Anda dapat menghapus layer awal DEM_WGS§4.

12.1.4 Kesimpulan
Alur kerja GRASS untuk mengolah data agak berbeda dari metode QGIS, karena GRASS me-
muat data ke dalam struktur basis data spasial. Namun, dengan menggunakan QGIS sebagai

antar muka, Anda dapat membuat pengaturan dari mapset GRASS lebih mudah dengan meng-
gunakan layer yang ada di QGIS sebagai sumber data untuk GRASS.

12.1.5 Apa Selanjutnya?

Sekarang data yang diimpor ke dalam GRASS, kita dapat melihat operasi analisis tingkat lanjut
yang disediakan oleh GRASS.

12.2 Pelajaran: Tool- Tool GRASS

Dalam pelajaran ini kita akan menyajikan pilihan fool untuk memberikan gambaran tentang
kemampuan GRASS.

12.2.1 @ Ikuti bersama: Mengatur Warna Raster

* Buka kotak dialog GRASS Tools .
e Carimodul r.colors.table di kolom Filter dari tab Modules List.

* Buka ool tersebut dan atur sebagai berikut:

Mame of input raster map

g_derm { g_demi@grass_mapset ) - ]:[

Type of color table

iZolor palette For Shutkle Radar Topography Mission elewation -

Ketika Anda menjalankan foo! ini, tool ini akan mewarnai kembali peta raster Anda:
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12.2.2 0 Ikuti bersama : Visualisasi Data dalam 3D

GRASS dapat digunakan untuk memvisualisasikan data DEM Anda dalam tiga dimensi. Tool
yang akan Anda gunakan untuk beroperasi pada Daerah GRASS, yang saat ini diatur ke seluruh
Afrika Selatan, sebagaimana telah Anda tetapkan diatas sebelumnya.

* Untuk mendefinisikan kembali cakupan dataset raster, klik tombol ini:

[y

Ketika fool ini diaktifkan, kursor anda akan berubah menjadi tanda silang ketika digerakkan di
atas peta QGIS.

* Dengan menggunakan tool ini, buatlah kotak persegi panjang sekitar tepi raster GRASS

» Klik OK pada kotak dialog GRASS Region Settings ketika telah selesai.

e Cari tool nviz:
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t¢ GRASS Tools: South_Africa/grass_mapset

Modules Tree Maodules List Browser |

Filker | mviz

- nwiz
- 3D-Yiewer (NYIZ)

== =

Close

* Atur seperti yang ditunjukkan berikut:

Mame of raster mapis) For Elevation

g_derm { g_dem@grass_mapsek ) - ]:[

Mame of raster map(s) For Colar

Marne of wector linesfareas overlay mapls)

g_streets [ g_streeks@grass_mapsek 1 line ) -

 Jangan lupa untuk mengaktitkan kedua tombol Use region of this map di bagian kanan
dari menu pilihan raster. Hal ini akan memungkinkan NVIZ untuk menilai resolusi raster
secara benar.

¢ Klik tombol Run.

NVIZ akan membuat gambaran 3D menggunakan data raster dan vektor terpilih. Proses ini
mungkin membutuhkan waktu yang lama, tergantung pada spesifikasi perangkat keras yang
digunakan. Ketika selesai, Anda akan melihat peta ditampilkan dalam 3D di jendela baru:
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NVIZ mEER
File  Appearance Visualize Scripting Help
oRaw | Clear | ancel |
Automatically render display: @
Show features:  Main features... — | Decarations.. — |
View method: = eve  center { flynone —i

Look

here __ [
height | Z-exal

113854 4 0.000C

center
top
reset

perspective {400 twist|0.0

j

Cobalah untuk melakukan pengaturan height, z-exag, dan View method untuk melihat data dari
sudut pandang yang lain. Anda membutuhkan waktu yang cukup untuk terbiasa dengan metode
navigasi yang digunakan.

12.2.3 % Ikuti bersama:Perangkat Mapcalc

* Buka kotak dialog GRASS Tools tab Modules List dialog dan cari calc.
» Dari Module list , pilih rmapcalc (jangan sampai keliru dengan rmapcalculator).
e Jalankan ool ini .

Dialog Mapcalc memungkinkan Anda untuk menjalankan analisis yang berurutan pada peta
raster, atau sekumpulan peta raster. Anda akan menggunakan fool ini untuk melakukannya:

Tool-tool yang akan digunakan adalah:
* Add map: menambahkan file raster dari mapset GRASS Anda saat ini.

* Add constant value:menambahkan nilai konstan yang akan digunakan dalam
fungsi.

* Add operator or function: menambahkan operator atau fungsi untuk dihu-
bungkan ke masukan dan keluaran.

* Add connection: menghubungkan elemen-elemen. Dengan menggunakan tool ini,
klik dan seret dari titik merah pada salah satu item ke titik merah pada item lain. Titik-
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titik yang terhubung secara benar ke saluran konektor, akan berubah abu-abu. Jika garis
atau titik berwarna merah, berarti titik-titik tersebut tidak terhubung dengan benar!

* Select item:Memilihitem dan memindahkan item yang dipilih.

* Delete selected item: Menghapus item yang dipilih dari lembar mapcalc saat
ini, tetapi bukan dari mapset (jika itu adalah raster yang ada).

Dengan menggunakan fool ini:
* buatlah algoritma berikut:

Maodule: r.mapcalc

Options Qukput Manual |

Cutpuk | altitude_range

» Ketika Anda mengklik Run, hasil yang diperoleh seharusnya terlihat seperti berikut:

r.mapcalc "altitude_range = {{{g_demi@grass_mapset <500} | | {g_demitgrass_mapset=1000)))"
Successfully finished

» Klik View output untuk melihat hasil operasi ditampilkan dalam peta:
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ol W

Hasil ini menunjukkan semua area yang memiliki ketinggian kurang dari dari 500 meter atau
lebih dari 1000 meter.

12.2.4 Kesimpulan

Dalam pelajaran ini, kita hanya membahas beberapa tool yang disediakan GRASS. Untuk
mengeksplorasi sendiri kemampuan GRASS, buka dialog GRASS Tools dan cari Modules List.
Cara yang lain, lihat di bawah tab Modules Tree, yang mangatur tool sesuai dengan jenisnya.
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